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Abstract 
 

Both the Smart IR module and the Integrated IR have been designed with the latest 

technology, using a microcontroller unit with an ARM7TDMI core and via software design 

the necessary techniques have been implemented to increase the reliability of the device 

therefore minimize the probability of faults. The Smart IR and the Integrated IR are user 

friendly electronic modules and are designed to fit directly on to SGX Sensortech’s existing 

Series 2 gas sensor product types like IR12GM_1 or IR11GM_1. The electronic module is 

designed to decrease the implementation time therefore increase productivity. The 

modules module incorporates the necessary electronics and embedded software to operate 

the infrared sensors from a low voltage DC power supply. The modules will sample the raw 

signals to output a linear, temperature compensated signal proportional to the gas 

concentration applied. The output signal is available in digital and analogue forms. Both the 

Smart IR module and the Integrated IR provide users with a simple method of incorporating 

an SGX Sensortech Infrared Sensor into their gas detection instrument which will 

significantly reduce the development time and expertise required during the design and 

implementation phases. The Smart IR and the Integrated IR can also be factory calibrated 

with the gas sensor to allow installation without the need for recalibration. The Integrated 

IR is by default calibrated in the factory unless otherwise required or ordered. The 

Evaluation Software designed to work with both the Integrated IR Digital Sensor and Smart 

IR Module. 
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Introduction 
 

The Smart IR has been designed to fit directly to SGX Sensortech’s 7-pin single gas 

products like the IR11GM_1 (Carbon Dioxide) and IR12GM_1 (Methane), which both contain 

a supported lamp for additional shock protection. Containing the necessary electronics and 

embedded software to send the linearized and temperature compensated concentration via 

Digital (32-bit) and Analog (14-bits) outputs, the Smart IR Configuration Unit can be used to 

configure, calibrate and evaluate the Smart IR and the Integrated IR via the USB interface 

with an easy-to-use PC software interface.  

Alternatively, control of the Smart IR and the Integrated IR via UART is available for 

communicating with an external microprocessor as well. The device itself contains full fault 

diagnostics, which are sent via the digital string along with the temperature output of the 

sensor and the linearized concentration. 

 

Summary of Contents  

 

In the first chapter we can find a tutorial including the guidelines for using the 

Evaluation Software, included within the Evaluation Kit, is being presented. Many examples 

and screenshots are embedded into the document for further understanding of the 

software’s tools as well as the installation process. The procedure is the same if we are using 

the Smart IR or the Integrated IR Sensor.  

At the end of this document we can find attached a table of coefficients for all the 

SGX’s Infrared Sensors that potentially can be used with the Evaluation Software or a 

custom made Evaluation Kit or instrument. 

Please find attached also in the end an index table for quick reference to the 

important part of this document. 
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Included in the Box 

 

The Evaluation Kits were designed for easy testing and experimental measurements 

as well as for production use. We can see below in the Figure a screenshot of the Evaluation 

Kit and what is included inside the package. Obviously depending on the application and the 

ordering code the Gas Sensor type or other components may vary. 

 

Included in the Box : 

 
1 x Smart IR Module or the Integrated IR Digital Sensor if ordered 

1 x Gas Sensor ( IR12GM_1/ IR11GM_1 etc… ) if ordered with the Smart IR Only 

1 x Configuration Unit with USB TTL Cable 

1 x CD/DVD, containing the Smart IR Evaluation Software 

1 x Electronic Version of the Smart IR Datasheet 

1 x Electronic Version of any Smart IR Application Notes 

1 x Electronic Version of the Integrated IR Datasheet 

1 x Electronic Version of any Integrated IR Application Notes 

1 x Electronic Version of this Integrated & Smart IR Evaluation Software User Guide 
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❶| Integrated & Smart IR Evaluation Software 
 

1.1 EVALUATION SOFTWARE INSTALLATION GUIDE 

 

In the Table 1.1 we can find the minimum and recommended system requirements 

for the computer on which the Evaluation Software will be installed. Windows is the only 

Operating System (OS) that the Evaluation Software Currently is working. 

 

Table 1.1 - Evaluation Software Minimum System Requirements 

 

 Minimum Requirements Recommended Requirements 

Processor Pentium III/Celeron 866 MHz Pentium core 2 duo or better 

RAM 1 Gb 3 Gb 

Screen 

Resolution 

1024 x 768 pixels minimum 1280 x 768 Pixels minimum 

Operating 

System 

Windows XP/7/Vista (32- and 64-bit) 

Windows Server 2003 R2 (32-bit) 

Windows Server 2008 R2 (64-bit) 

Windows 7/Vista (32- and 64-bit) 

 

Disk Space 1 Gb 3 Gb 

 

In order to use the Evaluation Software the TTL USB cable drivers should be installed 

in your PC. If you are using other operating system than Windows 7 or 8 with internet 

connection that can automatically find the drivers on the internet, please visit 

http://www.ftdichip.com/Products/Cables/USBTTLSerial.htm ,FTDi web site to download 

and install the appropriate driver for your operating system.   

 

 
 

 

 

 

 

IMPORTANT! 

The operating system that the Evaluation Software is targeting is Windows; 

there is no Evaluation solution for other operating systems at the moment. 

 

http://www.ftdichip.com/Products/Cables/USBTTLSerial.htm
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In order to install the Evaluation Software please follow the steps below: 

 

1. Insert the CD/DVD into the drive in the targeted computer. 

 

2. If the autorun is not working open the CD/DVD Drive, found inside the Computer 

place that contains the Installation CD. See the Figure below: 

 

 

 

Figure 1.1 – Open the CD/DVD in your Computer places 

 
3. Inside the CD/DVD find setup.exe, double click in order to start the installation. 

 

4. See below the installation screenshots for more details on the installation process: 

 

(a) Choose the installation folder, default is recommended 

 

   

 
Figure 1.2 – Choosing the installation folder for Evaluation Software 
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(b) Accept the License Agreement(s), press the next button. 

 

 

 
Figure 1.3 – Accept the License Agreement 

 
(b) Start Installation, press the next button. 

 

 

 
Figure 1.4 – Press next to start Installation Process 

 
(c) Wait for the Installation to finish, only takes a couple of minutes.   

 

The installation will only take a few minutes depending on the processing power of 

the computer being used. Along with the appropriate files that the Evaluation Kit needs to 

install there are some Run Time machines for the NI Labview software. These files are 

required for the application to run independently inside any computer without the need for 

the full NI Labview Software to be installed. Please see the Figure 1.5 including a screenshot 

taken during and after the installation has finished. 
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Figure 1.5 – Waiting for the installation to finish 

 
(c) Left Click on SGX Sensortech (Smart IR) -> Run as Administrator, from the Start 

Menu -> All Programs -> SGX Sensortech (Smart IR) or desktop shortcut (see below). 

 

 

 
Figure 1.6 – Inside All Programs in Start menu 
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1.2 USER INTERFACE of the EVALUATION SOFTWARE 

 
At the moment the current version of the Evaluation Software doesn’t have a 

Production Tab but in the final release it will be possible to calibrate the Zero and the Span 

simultaneously to all the connected devices. The Graphical User Interface (GUI) is simple 

and has been designed to increase productivity and solve engineering problems quickly. 

From the GUI it is possible to change the type of the values like the Temperature, in 

Celsius or Fahrenheit. There is the possibility to connect more than one Smart IR or 

Integrated IR Sensor and to read and change the settings to all of them at once. Moreover 

changing the coefficients can be done simultaneously by using a text file that contains the 

saved coefficients.  

The readings can also be logged and saved into a specific file. For the beta version of 

the Software there is no option for logging the data coming from all the connected devices 

at present time, although there is a Table View where the data coming from all the 

connected Smart IR or Integrated IR Devices can be observed. 

After running the application from the start menu or from the shortcut on our 

desktop we must be able to see the following window in the Figure 1.7 below. The window 

can be resized and fit most screen resolutions but a minimum of 1280 x 768 Pixels is 

recommended. 

 

 
 

Figure 1.7 – Screenshot from Evaluation Software 
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Menu Bar 

 
On the top left hand side we can find a menu bar File|Data|Hardware|Help. In the 

Table 1.2 below we can find the functionality of each menu item or submenu items that 

exist on that bar. 

 

Table 1.2 – Menu Bar Items on the Evaluation Software 

 

Menu Bar Submenu1 Submenu2 Description 

File → Show Scroll Bars  Show the scroll bars in the window 

Print Window…(Ctrl+P)  Print dialog for the current 

window 

Exit (Ctrl+Q)  Exit the evaluation software 

Data→ Temperature Units      → Celsius Shows the Temperature in 

Degrees Celsius (oC) 

Fahrenheit Shows the Temperature in 

Degrees Fahrenheit (oF) 

Concentration Units   → Percent Concentration  

in %vol of gas 

PPM Concentration in  

ppm = 10000* %vol 

CSV File Delimiter Comma(,) The saved coefficient file will use  

comma (,) to separate values. 

Semicolon(;) The saved coefficient file will use  

semicilon (;) to separate values. 

Hardware→ Update Firmware  Perform update of the firmware to 

the connected device. (Currently 

Disabled for the Beta Version) 

Help→ Software Disclaimer  Displays a software disclaimer 

statement. 

About  Displays the splash screen, with 

details about the software. 

 

1.2.1 COMMUNICATIONS TAB 

 

Configuration Unit (Connecting a device) 
 

In order to connect with a device we must first correctly connect the Smart IR or 

Integrated IR Configuration Unit with the computer running Windows and installed the 
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drivers for the TTL USB cable. Make sure the Smart IR and the Gas Sensor is plugged onto 

the Board too, before powering up the Configuration Unit.  

 First choose the COM port for the program to search in order to find the device, then 

press the “Search for devices” button on the Communications Tab to search for new devices 

connected to the PC. If we don’t know the exact port, we could use a range from 1 to 6 for 

example but do not overdo it by using a range from 1 to 25 because the Evaluation Software 

will search all the COMs for a device even if there is none connected which will take some 

time.By pressing the “Search for devices” button the process will be initialized and all the 

devices found will be displayed in the “Found Devices” field on the right hand side. We will 

be able to also see the COM Port that the device is connected the Serial Number of the 

Device and the Firmware version installed in the Smart IR module or the Integrated IR. 

Below we can see a screenshot of the Communications Tab and the process of 

searching of a new Smart IR or Integrated IR device. 

 

 
 

Figure 1.8 – Evaluation Software, “Communications Tab” 

 

In the same Tab we can configure the devices that we have found under the 

“Settings & Coefficients” section. By default the connected devices should be initially in 

Configuration Mode, where we could be able to read and write the coefficients of each 

device. We can Read the coefficients from a Single Device with the ability to “Write” new 

coefficients to all the devices that are connected to the computer. 

The configuration settings/coefficients can be saved to a text file to be used in the 

future and in the same way we can load settings/coefficients from a single text file. 

Therefore by having different text files for different sensors we can load and write the 
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configuration settings/coefficients effectively in all the devices that are connected to the 

computer. In addition to the above there are two ranges of coefficients that we can load, 

save, write or read, usually depending on the Concentration Ranges. For example we can 

have or create a text file that will include the coefficients for the low range of 5% Methane 

and the high range of 100% Methane. So each time we can choose a different range of 

coefficient depending on the application by clicking the Range 1 or Range 2 buttons at the 

bottom of the coefficients. 

 
1.2.2 READINGS & DATA LOGGING TAB 

 
In order to start evaluating the sensors we must set the device into “Engineering 

Mode” by setting the tick box, same think can happen by setting the device into Normal 

Mode but we won’t be able to see the Active and Reference counts. See below in Figure 1.9 

the screenshot of the software solution in the Readings & Data Logging Tab. 

 

 
 

Figure 1.9 – Evaluation Software, “Readings & Data Logging Tab” 

 

The Evaluation Software gives the ability to log the data coming from the Smart IR 

Module or the Integrated IR Sensor and to save it to a .csv type file. 
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Readings in Table View 
 

 
Figure 1.10 – “Start” Button to be clicked in Engineering Mode, Table View 

 
Data Logging the Readings & Graph View  
 

In order for us to be able to monitor the Sensor’s Readings we have to enable the 
data logging by pressing the “Start Logging” button. Doing so a new folder dialog will appear 
asking to choose the folder that the .csv file will be saved, see Figure 1.11. 

 

 
Figure 1.11 – Enabling Data Logging Function 
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By enabling the data logging we are now able to see the Graphical representation of 

the data coming via UART against time in seconds while the readings are being saved second 

by second to the file that we have identified before. When enough logged data has been 

collected press the “Stop Logging” button. The process can be started again in the same way 

and the data saved to the same file by overwriting it or to a different file.The .csv files 

generated above can be opened by using Microsoft Excel or any application that can handle 

spreadsheets and therefore we can produce Graphs from the data and even plot different 

sets of measurements comparing the results from different settings. 

In the “Readings & Data Logging Tab” it is possible to have at the same time a Table 

View and a Graph View of the elements that we are actually monitoring. By changing the 

“Graph View” roll down menu we can choose which Graph we want to observe but it is 

possible to see only one graph at a time and only from one Smart IR device or one 

Integrated IR Sensor. In case multiple devices are connected to the Evaluation Software 

solution then only the first one will be monitored in the Graph View although all of them will 

be visible to the Table View. In the Figure 1.11 we can see the Graph: Concentration while 

the Data logging is enabled in the “Readings & Data Logging” Tab.  

 

 
 

Figure 1.12 - Readings Send via the UART in Engineering Mode, Graph: Temperature 

 

Translating the “Faults” Code 
 

The Fault is a 32-bit unsigned integer number that is representing all the errors 

either code or hardware related. The Fault is transmitted via the UART second in place after 

the Concentration in ppm. Each 4-bits of the Fault variable can represent different levels of 

errors so we can simultaneously monitor 8 different errors from 8 different parts in terms of 
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hardware or software. The association between the Fault variable and the different states of 

errors can be found below in the Table 1.3 – Faults/Errors Interpretation.  

To interpret the Fault variable, first identify the Assigned Digit that we want to 

translate then the function/error that is representing from the column Associated Part and 

finally the Meaning of the error depending on the value of the digit. 

    
Table 1.3 – Faults/Errors Interpretation 

 
Variable Associated  

Part  

Assigned  

DIGIT 

Error  

Meaning 

Value 

UART 

Fault ALL Parts 7 to 0 NO ERROR IN ALL PARTS  (EVERYTHING OK )*1 0xAAAAAAAA 

ENABLED Gas Sensor 0 NO ERROR 0x0000000A 

   01-Sensor not Present 0x00000001 

   02-Temperature sensor not working OR 
Device Temperature Out of the Operating Range 

0x00000002 

   03-Active or Reference are weak 0x00000003 

   04-First Time Configuration Mode, no settings present 0x00000004 

ENABLED Power Related 1 NO ERROR 0x000000A0 

   01-Last Reset was because of a Power on Reset 0x00000010 

   02-Last Reset was because of a Watchdog Timer 0x00000020 

   03-Last Reset was because of a Software Reset 0x00000030 

   04-Last Reset was because of an External Interrupt 0x00000040 

   05-Not assigned yet 0x00000050 

DISABLED ADC Related 2 NO ERROR 0x00000A00 

   01-ADC is switched off 0x00000100 

   02-Weak Signals Received 0x00000200 

   03-Not assigned yet 0x00000300 

ENABLED DAC Related 3 NO ERROR 0x0000A000 

   01-DAC is switched off 0x00001000 

   02-DAC output disable in Configuration mode 0x00002000 

ENABLED UART Related*2 4 NO ERROR 0x000A0000 

   01-Break Indicator P1.0 set LOW for more than the 

maximum word length 

0x00010000 

   02-Framing Error, stop bit was invalid 0x00020000 

   03-Parity Error, stop bit was invalid 0x00030000 

   04-Overrun Error, data overwrite before being read 0x00040000 

DISABLED TIMERS Related 5 NO ERROR 0x00A00000 

   01-Timer1 Error 0x00100000 

   02-Timer2/Watchdog Error 0x00200000 

   03-Not assigned yet 0x00300000 

DISABLED General Error 6 NO ERROR 0x0A000000 

   01-Main loop is not executed 0x01000000 

   02-Not assigned yet 0x02000000 

ENABLED MEMORY 

Related*3 

7 NO ERROR 0xA0000000 

   01-Unable to store Data, to the Device 0x10000000 

   02-Unable to read Data from the Device 0x20000000 

   03-Not assigned yet 0x30000000 

*1: It normal to get a Fault = 0xAAAAAA1A because the “1” in the second digit representing the Power on Reset process 

of the MCU which is a normal operation when we turn on the Smart IR or the Integrated IR 

*2: This is the function that will check the UART Status (COMSTA0) register, to produce a fault depending on the 
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previous experience. Obviously if the error is serious we will not be able to receive the message via UART, but we can 

check it later to find out what caused it. 

*3: The Memory will work correctly as long as the MCU is working but it will not be able to store the data in the flash 

upon reset, if the Error 01 is present. If we cannot read the Memory then check the Mode you are working, the memory 

cannot be read other than CONFIGUATION MODE. 

 

1.2.3 CALIBRATION in “Readings & Data Logging” 

 
In the same tab Readings & Data Logging we can perform the Zero Calibration 

Routine, the Span Calibration Routine and the Offset Calculation on the Device(s) we have 

selected on a left hand side (see Figure 1.12.) 

 

 
 

Figure 1.13 – Evaluation Software, Calibration Routine 

 

ZERO CALIBRATION 
 
 We can perform the “Zero” calibration routine by sending the correct command 

while the Smart IR or Integrated IR is in NORMAL or ENGINEERING mode. Please make sure 

that the value we have set in the configuration Tab matches the percentage of 

concentration of the gas used. Performing the Zero calibration with different percentage of 

concentration as default value comparing with the Gas Sensor type will result unstable 

readings and may cause false alarms as well. 

 

SPAN CALIBRATION 
 

We can perform the “Span” calibration routine by sending the correct command 

while the Smart IR or the Integrated IR is in NORMAL or ENGINEERING mode, see 
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Application Note 1 and 2. Please make sure that the value we have set in the configuration 

Tab matches the percentage of concentration of the gas used. Performing the Span 

calibration with different percentage of concentration as default value comparing with the 

Gas Sensor type will result unstable readings and may cause false alarms as well.  

 

 
 

It is important to perform both zero and span calibration routines in the same 

controlled environmental conditions of ambient temperature, humidity and pressure 

without strengthening the components above the maximum ratings presented into the 

technical specifications table.  

Last but not least will be also advisable to perform the zero calibration under 

nitrogen gas first and then the span calibration exposing the sensor into the target gas that 

you want to detect. In both cases the Active and Reference counts representing the Peak-to-

Peak voltage of the signals accordingly along with the temperature the moment of the 

calibration, are stored inside the Flash/EE memory of the Smart IR or the Integrated IR 

Sensor and can be read back by performing the appropriate command.   

 

 
 
Offset Calculate  
 
 We can perform the “Offset” calculation by sending the appropriate command while 

the Smart IR or Integrated IR is in NORMAL or ENGINEERING mode. Please make sure that 

the value we have set in the configuration Tab matches the percentage of concentration of 

the Offeset Gas used. Performing the Offset calibration with different percentage of 

concentration as default value comparing with the Gas Sensor type will result unstable 

readings and may cause false alarms as well. 

 

1.2.4 ENGINEERING TAB 
 

In the Engineering Tab it is possible to observe the incoming string of data via the 

UART each second. In the specific Tab we can also find information about all the settings 

IMPORTANT! 
  It is advisable to do the Span and Zero Calibration after we have left the sensor 

for 35-40 minutes to warm up.  

IMPORTANT! 
Beware that selecting different concentration ranges via the Evaluation 

Software or with the low level microcontroller implementation, the steps of the 
calibration routine should be performed again. By changing the concentration ranges 
we only changing the coefficients for that range and not the stored data of the 
calibration; we have to perform a recalibration process anyway.  
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that are now valid on the Evaluation Application. Some of the information present at any 

given time is the Concentration, Temperature and Text Separation settings.  

There are LEDs indicating the different conditions in real time of the received data, 

see in the Table 1.4 in the next page. 
 

Table 1.4 – LEDs Meaning in the Engineering Tab 

LED Indicator Description - Meaning 

Gettings Readings? If the LED is on then the Readings are coming via UART 

Logging Data? If the LED is on then the Readings are being logging in real-time 

Data Ready? Every time software receives data, LED is on, almost every 1 second 

Not Running? If data will not be updated in real time and the LED will be on. 

Clear Data? If we clear the data in the Graphs LED will be on instantly and the off again 

 

There are also three directories that we can see in the Engineering Tab and those are 

the “Coefficient File Directory”, which contains the text files of the range settings for the 

Smart IR Module or the Integrated IR Sensor. The “Log File Path” is the path name where 

the logged data is stored in the type .csv files. Final the “Log File Basic Directory” is the path, 

where by default the logged data is being saved. In Figure 3.13 that we can see everything 

that we have described before.  

 

 
Figure 1.13 – Evaluation Software, “Engineering Tab” 

 

In the right hand side there is a table view that includes date and time the data are 

being received. In addition to the above, we can see in the table the set of readings in 

hexadecimal format as they are being received in real time from the digital string output of 

the Smart IR or the Integrated IR Sensor. 
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Appendix A  

Table of Coefficients 
 

Please read the applicable Smart IR Application Note or the INIR Application 

Note for the correct ranges and the coefficient depending on the version of the 

Firmware that your Smart IR Module is utilizing. There are a few changes in 

coefficients from versions 1vX, 2vX, 3vX to the new version 4vX and above that. 

Always make sure you are using the correct coefficients as the performance of the 

Smart IR and the Integrated IR Sensor would be affected by those values. 

 
 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

NOTE: 
1. These coefficients are based upon results measured at SGX Sensortech (IS) 

Ltd using standard test equipment. These coefficients may vary slightly when using 
different circuits. It may be required to recalculate some of these coefficients if small 
inaccuracies are observed during testing (refer to Infrared Sensor Application Note 5 
for determination of coefficients). 

2. For sensor variants with a “_1” suffix (supported lamp versions), use the 
equivalent non-supported lamp version. For example for an IR11GM_1, use 
coefficients for the IR11GM. 
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Компания «ЭлектроПласт» предлагает заключение долгосрочных отношений при 
поставках импортных электронных компонентов на взаимовыгодных условиях! 

 
Наши преимущества: 

 Оперативные поставки широкого спектра электронных компонентов отечественного и 
импортного производства напрямую от производителей и с крупнейших мировых 
складов; 

  Поставка более 17-ти миллионов наименований электронных компонентов; 

 Поставка сложных, дефицитных, либо снятых с производства позиций; 

 Оперативные сроки поставки под заказ (от 5 рабочих дней); 

 Экспресс доставка в любую точку России; 

 Техническая поддержка проекта, помощь в подборе аналогов, поставка прототипов; 

 Система менеджмента качества сертифицирована по Международному стандарту ISO 
9001; 

 Лицензия ФСБ на осуществление работ с использованием сведений, составляющих 
государственную тайну; 

 Поставка специализированных компонентов (Xilinx, Altera, Analog Devices, Intersil, 
Interpoint, Microsemi, Aeroflex, Peregrine, Syfer, Eurofarad, Texas Instrument, Miteq, 
Cobham, E2V, MA-COM, Hittite, Mini-Circuits,General Dynamics и др.); 
 

Помимо этого, одним из направлений компании «ЭлектроПласт» является направление 
«Источники питания». Мы предлагаем Вам помощь Конструкторского отдела: 

 Подбор оптимального решения, техническое обоснование при выборе компонента; 

 Подбор аналогов; 

 Консультации по применению компонента; 

 Поставка образцов и прототипов; 

 Техническая поддержка проекта; 

 Защита от снятия компонента с производства. 
 
 
 

 
 

Как с нами связаться 

Телефон: 8 (812) 309 58 32 (многоканальный)  
Факс: 8 (812) 320-02-42  
Электронная почта: org@eplast1.ru  

Адрес: 198099, г. Санкт-Петербург, ул. Калинина, 

дом 2, корпус 4, литера А.  
 

mailto:org@eplast1.ru

